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BAB III 

OBJEK DAN DESAIN PENELITIAN 

3.1. Objek Penelitian  

Pada penelitian ini objek penelitian terdiri atas dua variabel, yakni variabel 

Tata Ruang Kantor dan variabel Produktivitas Kerja. variabel Tata Ruang Kantor 

disebut sebagai variabel bebas (Independent Variable) sedangkan variabel 

Produktivitas Kerja disebut sebagai variabel terikat (Dependent Variable). 

Penelitian ini dilakukan di Dinas Sosial Kota Bandung, yang beralamatkan di Jl. 

Babakan Karet, Derwati, Kec. Rancasari, Kota Bandung, Jawa Barat 40292. 

 

3.2. Desain Penelitian 

3.2.1. Metode Penelitian 

Jenis penelitian yang digunakan adalah penelitian dengan metode deskriptif 

kuantitatif untuk mengetahui apakah ada hubungan antara variabel bebas dengan 

variabel terikat yaitu tata ruang kantor sebagai penyebab dan produktivitas kerja 

pegawai di kantor pelayanan Dinas Sosial Kota Bandung sebagai akibat yang 

menggambarkan objek penelitian secara verbal melalui data yang telah 

terkumpul dan juga penyebaran angket kepada responden.  

Menurut Sugiyono (2010), penelitian kuantitatif adalah metode penelitian 

yang berlandaskan pada filsafat positivisme yang digunakan untuk meneliti pada 

populasi atau sampel tertentu, teknik pengambilan sampel pada umumnya 

dilakukan secara random, pengumpulan data digunakan instrumen penelitian 

analisis data bersifat kuantitatif/statistik dengan tujuan untuk menguji hipotesis 

yang telah ditetapkan. Sementara penelitian deskriptif yaitu penelitian yang 

dilakukan untuk mengetahui gambaran suatu variabel, baik satu variabel atau 

lebih, tanpa membuat perbandingan atau menghubungkannya dengan variabel 

yang lain. Penelitian deskriptif ini digunakan untuk memperoleh gambaran 

tentang Tata Ruang Kantor dan Produktivitas Kerja Pegawai di Kantor 

Pelayanan Dinas Sosial Kota Bandung. 
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Teknik pengumpulan data dilakukan yaitu dengan peneliti terjun langsung 

ke lapangan (lokasi penelitian) untuk mendapatkan data yang diperlukan dengan 

dilakukannya wawancara dan penyebaran angket kepada seluruh pegawai 

Kantor Pelayanan Dinas Sosial Kota Bandung dengan penilaian dengan 

menggunakan skala Likert. Teknik analisis data yang dilakukan yaitu dengan uji 

validitas dan reliabilitas, teknik analisis data deskriptif dan inferensial, uji asumsi 

klasik, analisis regresi linier, uji t, dan koefisien determinasi.  

Dengan demikian, metode penelitian yang digunakan yaitu metode 

kuantitatif deskriptif, yang mana metode kuantitatif ini pada umumnya dilakukan 

pada sampel secara random yang kemudian dapat peneliti generalisasikan pada 

populasi dimana sampel tersebut diambil, dan metode deskriptif ini juga meliputi 

penilaian sikap atau pendapat terhadap individu, organisasi, ataupun keadaan 

mengenai hubungan kausalitas antara tata ruang kantor dengan produktivitas 

kerja pegawai di Kantor Pelayanan Dinas Sosial Kota Bandung. 

3.2.2. Operasional Variabel Penelitian 

Dalam penelitian kuantitatif, suatu fenomena dapat diklasifikasikan menjadi 

variabel-variabel. Seperti yang dikatakan oleh Sugiyono (2012) bahwa variabel 

penelitian merupakan segala sesuatu yang ditetapkan penulis untuk kemudian 

dipelajari dalam memperoleh informasi, sehingga dapat diambil kesimpulan. 

Dalam penelitian ini penulis melakukan pengukuran terhadap keberadaan suatu 

variabel dengan menggunakan instrumen penelitian. Setelah itu penulis akan 

melanjutkan analisis untuk mencari pengaruh suatu variabel dengan variabel 

lain.  

Menurut Sugiyono (2019), variabel dapat dibedakan menjadi dua yaitu 

sebagai berikut: 

1. Variabel Independen (Variabel Bebas) merupakan variabel yang 

mempengaruhi atau menjadi sebab perubahannya atau timbulnya 

variabel dependen (terikat). 

2. Variabel Dependen (Variabel Terikat) merupakan variabel yang 

dipengaruhi atau yang menjadi akibat karena adanya variabel bebas.   
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Penelitian ini terdiri dari dua pokok variabel, yaitu variabel Tata Ruang 

Kantor (X) sebagai variabel independen atau variabel bebas dan Produktivitas 

Kerja Pegawai (Y) sebagai variabel dependen atau variabel terikat.  

1. Operasional Variabel Tata Ruang Kantor 

Tabel 3.1 

Operasional Variabel Tata Ruang Kantor 

Variabel Indikator Ukuran Skala 
Nomor 

Item 

Tata Ruang 

Kantor (X)  

“Penentuan 

kebutuhan 

mengenai 

pertimbangan 

atau 

perencanaan 

spasial, 

perencanaan 

ruangan, 

perlengkapan 

atau perabot, 

tata cahaya, 

warna, dan 

pesan-pesan 

yang 

disampaikan 

secara grafis. 

Yang dapat 

digunakan 

1. Pertimbangan 

atau 

perencanaan 

spasial 

1. Tingkat 

pertimbangan 

dalam 

menentukan 

ruangan 

dengan 

jumlah 

pegawai. 

Ordinal 1 

2. Tingkat 

pertimbangan 

dalam 

menentukan 

perabot dan 

perlengkapan 

kantor sesuai 

dengan luas 

ruangan. 

Ordinal 2 

2. Perencanaan 

ruangan  

3. Tingkat 

perencanaan 

dalam 

penentuan 

Ordinal 3 
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untuk 

menyelesaikan 

urusan-urusan 

perkantoran. 

(Mudie & 

Cottam, 2004) 

jenis tata 

ruang kantor. 

4. Tingkat 

perencanaan 

dalam 

penentuan 

desain 

ruangan 

berdasarkan 

aktivitas 

kantor. 

Ordinal 4 

5. Tingkat 

perencanaan 

dalam 

penentuan 

alur kerja 

pegawai. 

Ordinal 5 

3. Perlengkapan 

atau 

perabotan 

6. Tingkat 

kelengkapan 

perabotan 

dan peralatan 

kantor 

berdasarkan 

kebutuhan 

pegawai. 

Ordinal 6 

7. Kesesuaian 

dalam 

penentuan 

tata letak 

perabotan 

Ordinal 7 
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dan peralatan 

kantor 

berdasarkan 

luas ruangan 

yang ada. 

8. Ketepatan 

dalam 

penempatan 

perabot 

kantor yaitu 

mesin-mesin 

kantor. 

Ordinal 8 

9. Kelengkapan 

penempatan 

perabot 

kantor yaitu 

lemari arsip. 

Ordinal 9 

4. Tata cahaya 10. Ketersediaan 

cahaya yang 

masuk ke 

dalam 

ruangan. 

Ordinal 10 

11. Tingkat 

kesesuaian 

antara cahaya 

dengan jenis 

dan sifat 

pekerjaan 

yang 

dilakukan. 

Ordinal 11 
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12. Tingkat 

ketajaman 

tata cahaya 

bagi 

penglihatan. 

Ordinal 12 

5. Warna  13. Tingkat 

kesesuaian 

warna 

perabotan 

dan peralatan 

kantor 

dengan 

warna 

dinding 

kantor. 

Ordinal 13 

14. Efek warna 

yang dapat 

menimbulkan 

kesan rileks. 

Ordinal 14 

6. Pesan-pesan 

yang 

disampaikan 

15. Kelengkapan 

tanda atau 

petunjuk 

pesan yang 

disampaikan 

untuk 

maksud 

tertentu.   

Ordinal 15 
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3. Operasional Variabel Produktivitas Kerja Pegawai 

Tabel 3.2 

Operasional Variabel Produktivitas Kerja Pegawai 

Variabel Indikator Ukuran Skala 
Nomor 

Item 

Produktivitas 

Kerja 

Pegawai (Y) 

“Produktivitas 

kerja pegawai 

adalah 

kemampuan 

memperoleh 

manfaat yang 

sebesar-

besarnya dari 

sarana dan 

prasarana 

yang tersedia 

dengan 

menghasilkan 

output yang 

optimal, 

bahkan kalau 

mungkin yang 

maksimal” 

(Sondang 

Siagian, 2009) 

1. Kualitas Hasil 

Kerja 

Karyawan  

1. Tingkat 

kerapihan 

pekerjaan 

Ordinal 1 

2. Tingkat 

keakuratan 

pekerjaan 

yang 

dihasilkan 

Ordinal  2 

3. Tingkat 

ketaatan 

pegawai 

dalam 

mengerjakan 

tugas yang 

diberikan 

Ordinal 3 

4. Tingkat 

motivasi 

untuk 

meningkatkan 

kinerja 

Ordinal 4 

2. Kuantitas 

Hasil Kerja 

Karyawan 

5. Banyaknya 

pelayanan 

yang 

dilakukan 

Ordinal 5 

6. Banyaknya Ordinal 6 
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dokumen 

yang dibuat 

dan/atau 

dicetak 

7. Tingkat 

capaian target 

dalam bekerja 

 7 

3. Waktu dan 

kecepatan 

kerja 

karyawan 

untuk 

menyelesaikan 

pekerjaan  

8. Tingkat 

inisiatif 

pegawai 

Ordinal 8 

9. Tingkat 

kecepatan 

dalam 

pelaksanaan 

pekerjaan 

Ordinal 9 

10. Tingkat 

keseriusan 

pegawai saat 

bekerja 

Ordinal 10 

11. Tingkat 

ketepatan 

waktu 

pegawai 

dalam 

kehadiran 

bekerja 

Ordinal 11 

 12. Tingkat 

ketepatan 

waktu dalam 

Ordinal 12 
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mengerjakan 

tugas 

 

3.2.3. Populasi dan Sampel Penelitian 

Populasi adalah keseluruhan elemen, atau unit penelitian, atau unit analisis 

yang memiliki ciri atau karakteristik tertentu yang dijadikan sebagai objek 

penelitian atau perhatian dalam suatu penelitian atau pengamatan. Dengan kata 

lain populasi tidak terbatas pada sekelompok orang melainkan apa saja yang 

telah menjadi perhatian kita. (Abdurrahman, Muhidin, Somantri, 2017). 

Sementara menurut Sugiyono (2019), populasi merupakan keseluruhan elemen 

yang akan dijadikan wilayah generalisasi yang terdiri dari objek maupun subjek 

yang memiliki karakteristik khusus sesuai dengan ketetapan peneliti untuk 

kemudian dipelajari dan ditarik kesimpulan. Populasi pada penelitian ini adalah 

Pegawai Dinas Sosial Kota Bandung, sebagaimana yang tercantum pada tabel: 

Tabel 3.3 

Jumlah Populasi di Dinas Sosial Kota Bandung 

No Jenis Populasi Jumlah 

1. Golongan I 0 pegawai 

2. Golongan II 0 pegawai 

3. Golongan III 48 pegawai  

4. Golongan IV 16 pegawai 

Total Populasi  64 pegawai 

Sumber: Data Kinerja Pegawai Dinas Sosial Kota Bandung 2023 

Sedangkan sampel penelitian merupakan bagian kecil dari jumlah populasi 

yang ada. Dalam penelitian ini, peneliti menggunakan sampel sesuai dengan 

ukuran sampel minimal yakni seluruh pegawai ASN yang bekerja di bagian 

Pelayanan Sosial dengan jumlah 30 Pegawai. 

 

3.2.4. Teknik dan Alat Pengumpulan Data 

Teknik pengumpulan data adalah cara yang dapat digunakan oleh peneliti 
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untuk mengumpulkan data mengenai objek penelitian. Data yang sudah 

terkumpul, kemudian di analisis dan diuraikan. Tujuannya yaitu untuk 

memperoleh ukuran tentang Pengaruh Tata Ruang Kantor Terhadap 

Produktivitas Kerja Pegawai. Pengumpulan data dapat dilakukan dengan 

beberapa teknik, maka dalam penelitian ini alat atau teknik pengumpulan data 

yang digunakan adalah sebagai berikut: 

1. Wawancara atau interviu 

Teknik wawancara dalam penelitian ini dilakukan ketika peneliti 

melakukan kegiatan pra penelitian dengan tujuan untuk mencari data dan 

keterkaitan dengan masalah yang dikaji dalam penelitian ini. Wawancara 

dilakukan kepada beberapa pegawai yang memiliki tugas dan wewenang 

yang berkaitan dengan masalah yang diteliti. Wawancara telah dilakukan 

pada tanggal 22 Februari 2023 bersama Ibu Noor Malia selaku Kepala Sub 

Bagian Umum dan Kepegawaian Dinas Sosial Kota Bandung dan pada 

tanggal 8 Maret 2023 bersama Bapak Ahmad Rahayu selaku Pengelola 

Perlindungan Sosial Dinas Sosial Kota Bandung. 

2. Angket atau Kuisioner 

Dalam penelitian ini, teknik pengumpulan data yang digunakan guna 

mendapatkan data yang diperlukan dalam penelitian adalah teknik kuisioner. 

Menurut Sugiyono (2018) kuisioner merupakan teknik pengumpulan data 

dengan memberikan seperangkat pertanyaan atau penyataan tertulis kepada 

responden untuk menjawab hal-hal yang ingin diketahui peneliti. Dalam 

menyusun kuisioner, penulis berpedoman pada variabel-variabel terkait. 

Kuisioner akan disebarkan kepada pegawai dalam Bidang Pelayanan di 

Dinas Sosial Kota Bandung dengan instrument tentang Tata Ruang Kantor 

(X) dan produktivitas kerja (Y). Prosedur penyusunan kuisioner penelitian 

adalah sebagai berikut: 

1) Menyusun daftar pertanyaan dan alternatif jawaban  

Merumuskan item-item pertanyaan dan alternatif jawaban. Angket 

yang digunakan merupakan angket tertutup yang terdiri dari lima 
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alternatif jawaban angket yang disesuaikan dengan ukuran variabelnya.  

2) Menetapkan skala penilaian angket 

Skala penilaian jawaban angket pada penelitian ini adalah skala 

likert. Menurut Riduwan dan Sunarto (2017) “Skala Likert adalah skala 

yang digunakan untuk mengukur sikap, pendapat dan persepsi seseorang 

tentang kejadian atau gejala sosial”.  

3) Melakukan uji coba angket 

Sebelum mengumpulkan data penelitian sebenarnya, terlebih dahulu 

dilakukan uji coba angket tersebut dilakukan untuk mengetahui 

kekurangan pada item angket yang dibuat. Dalam penelitian ini juga 

diperlukan studi kepustakaan yang akan dijadkan bahan perbandingan, 

acuan dan landasan teoretis yang berkaitan erat dengan masalah yang 

akan diteliti. 

Tabel 3.4  

Skala Penilaian Jawaban Angket 

No. Pernyataan 
Alternative Jawaban 

1 2 3 4 5 

Keterangan alternative jawaban: 

1 = Sangat Tidak Setuju 

2 = Kurang Setuju 

3 = Tidak Setuju 

4 = Setuju 

5 = Sangat Setuju 

 

3.2.5. Pengujian Instrumen Penelitian 

Kegiatan pengujian instrument meliputi dua hal, yaitu pengujian validitas 

dan reliabilitas. Pengujian validitas dan reliabilitas ini merupakan suatu hal yang 

penting dalam sebuah penelitian karena untuk memaksimalkan kualitas ukur 

agar dapat meminimalisir adanya kekeliruan. Menurut Sugiyono (2019), 

penelitian dapat dikatakan valid bila terdapat kesamaan antara data yang 
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terkumpul dengan data yang sesungguhnya terjadi pada objek yang diteliti. 

Sedangkan penelitian dikatakan reliabel, apabila terdapat kesamaan data dalam 

waktu yang berbeda. Dengan menggunakan instrument yang valid dan reliabel 

dalam pengumpulan data, maka diharapkan hasil penelitian akan menjadi valid 

dan reliabel. Instrument valid dan reliabel menjadi syarat mutlak untuk 

mendapatkan hasil penelitian yang valid dan reliabel.  

Uji coba angket dilakukan terhadap 21 responden, yaitu kepada pegawai 

Dinas Lingkungan Hidup Provinsi Jawa Barat. Data angket yang sudah 

terkumpul kemudian dihitung validitas dan reliabilitasnya dengan jumlah item 

angket yang dapat dilihat pada tabel berikut: 

Tabel 3.5 

Jumlah Angket Uji Coba 

No  Variabel  Jumlah Item Angket 

1 Tata Ruang Kantor 15 

2 Produktivitas Kerja 12 

Total  27 

 

1. Uji Validitas Intrumen 

Uji validitas adalah suatu ukuran yang menunjukkan tingkat kehandalan 

suatu instrumen yang dapat dilihat pada hasil korelasi pearson product 

moment. Alat ukur (instrumen) yang digunakan dalam penelitian harus tepat 

(valid). Pengujian validitas instrumen digunakan untuk mengetahui seberapa 

besar ketepatan dan ketelitian suatu alat ukur di dalam mengukur gejalanya. 

Rumus yang digunakan untuk menguji validitas adalah dengan rumus 

formula koefisien korelasi Product Moment dari Karl Pearson yaitu:  

 

   rxy = 
𝑁 ∑ 𝑋𝑌 −  ∑ 𝑋 .∑ 𝑋 

√[𝑁 ∑ 𝑋2 − (∑ 𝑋)2] [𝑁 ∑ 𝑌2 − (∑ 𝑌)2]
 

Keterangan: 

rxy  :  Koefisien korelasi antaravariabel X dan Y  

X :  Skor pertama, dalam hal ini X merupakan skor-skor pada item keil  
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  yang akan diuji validitasnya.  

Y  :  Skor kedua, dalam hal ini Y merupakan jumlah skor  

  yang diperoleh tiap responden. 

∑X :  Jumlah skor dalam distribusi X 

∑Y  :  Jumlah skor dalam distribusi Y  

∑ 𝑋2  :  Jumlah jumlah kuadrat dalam skor distribusi X   

∑ 𝑌2  :  Jumlah jumlah kuadrat dalam skor distribusi Y  

N  :  Banyaknya responden 

Berikut ini merupakan langkah kerja yang dapat dilakukan dalam rangka 

mengukur validitas instrumen penelitian adalah sebagai berikut: 

a. Menyebarkan instrumen yang akan diuji validitasnya, kepada responden 

yang bukan responden sesungguhnya.  

b. Mengumpulkan data hasil uji coba instrumen.  

c. Memeriksa kelengkapan data, untuk memastikan lengkap tidaknya 

lembaran data yang terkumpul. Termasuk di dalamnya memeriksa 

kelengkapan pengisian item angket.  

d. Membuat tabel pembantu untuk menempatkan skor-skor pada item yang 

diperoleh.  

e. Memberikan/menempatkan skor (scoring) terhadap item-item yang 

sudah diisi pada tabel pembantu.  

f. Menghitung nilai koefisien korelasi product moment untuk setiap 

bulir/item angket dari skor-skor yang diperoleh. 

g. Menentukan nilai tabel koefisien korelasi pada derajat bebas (db) = n –

2, di mana n merupakan jumlah responden yang dilibatkan dalam uji 

validitas, yaitu 10 orang sehingga diperoleh db = 10-2 = 8 dan α = 5%  

h. Membuat kesimpulan, dengan cara membandingkan nilai r hitung dan 

nilai r tabel, dengan kriteria sebagai berikut:  

1) Jika rhitung > rtabel maka item instrumen dinyatakan valid. 

2) Jika rhitung ≤ rtabel maka item instrumen dinyatakan tidak valid. 

(Muhidin, 2010) 
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Adapun hasil uji validitas dari uji instrument mengenai variabel Tata 

Ruang Kantor (X) dan variabel Produktivitas Kerja Pegawai (Y) dengan 

menggunakan alat bantu statistika yaitu Software (Statistic Product and 

Service Solutions) version 25.0 adalah sebagai berikut: 

1) Input data per item dan total dari setiap variabel (variabel X dan Y) 

masing-masing ke dalam SPSS 

2) Pilih menu pada tab analyze > correlate > bivariate 

3) Pindahkan seluruh item berikut dengan total nya ke dalam kotak 

variabel 

4) Beri tanda ceklis pada option pearson, two tailed, dan flag significant 

correlations, dan klik OK. 

Berikut akan disajikan tabel hasil uji validitas dari angket uji coba 

dengan responden sebanyak 21 orang di Dinas Lingkungan Hidup Provinsi 

Jawa Barat. Angket yang diuji cobakan yaitu sebanyak 15 item untuk 

variabel tata ruang kantor dan 12 item untuk variabel produktivitas kerja. 

Tabel 3.6 

Hasil Uji Validitas untuk Variabel Tata Ruang Kantor 

No Item Nilai r Hitung Nilai r Tabel Keterangan 

1 0,532 0,433 Valid 

2 0,609 0,433 Valid 

3 0,606 0,433 Valid 

4 0,653 0,433 Valid 

5 0,639 0,433 Valid 

6 0,498 0,433 Valid 

7 0,458 0,433 Valid 

8 0,626 0,433 Valid 

9 0,559 0,433 Valid 

10 0,536 0,433 Valid 

11 0,668 0,433 Valid 

12 0,476 0,433 Valid 

13 0,450 0,433 Valid 

14 0,639 0,433 Valid 

15 0,574 0,433 Valid 
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Sumber: Data Hasil Uji Instrumen Penelitian 

Tabel 3.7 

Hasil Uji Validitas untuk Variabel Produktivitas Kerja 

No Item Nilai r Hitung Nilai r Tabel Keterangan 

1 0,543 0,433 Valid 

2 0,680 0,433 Valid 

3 0,653 0,433 Valid 

4 0,492 0,433 Valid 

5 0,521 0,433 Valid 

6 0,550 0,433 Valid  

7 0,693 0,433 Valid  

8 0,667 0,433 Valid  

9 0,690 0,433 Valid  

10 0,597 0,433 Valid  

11 0,589 0,433 Valid  

12 0,578 0,433 Valid  

Sumber: Data Hasil Uji Instrumen Penelitian 

Berdasarkan tabel hasil uji validitas di atas, dapat terlihat bahwa 15 item 

pada variabel Tata Ruang Kantor dan 12 item pada variabel Tata Ruang 

Kantor semuanya dinyatakan valid karena rhitung > rtabel. 

 

2. Uji Reliabilitas Instrumen 

Tujuan dilakukannya uji reliabilitas yakni untuk mengetahui konsistensi 

dari instrumen sebagai alat ukur sehingga suatu pengukuran dapat dipercaya 

atau reliabel. Formula yang digunakan untuk menguji reliabilitas instrumen 

pada penelitian ini yaitu Koefisien Alfa (α) dari Cronbach: 

 r11 = [
𝑘

𝑘−1
] . [1 − 

∑ 𝜎𝑖
2

𝜎𝑡
2 ] 

Keterangan: 

𝑟11  :  Reliabilitas instrumen/koefisien korelasi/korelasi alpha  

k :  Banyaknya bulir soal  

∑𝜎𝑖
2  :  Jumlah varians bulir  

𝜎𝑡
2  :  Varians total  
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∑X  :  Jumlah skor  

N  :  Jumlah responden 

Berikut ini merupakan langkah kerja yang dapat dilakukan dalam rangka 

mengukur reliabilitas instrumen penelitian menurut Muhidin (2010) adalah 

sebagai berikut:   

a. Menyebarkan instrumen yang akan diuji reliabilitasnya, kepada 

responden yang bukan responden sesungguhnya.  

b. Mengumpulkan data hasil uji coba instrumen.  

c. Memeriksa kelengkapan data, untuk memastikan lengkap tidaknya 

lembaran data yang terkumpul. Termasuk di dalamnya memeriksa 

kelengkapan pengisian item angket.  

d. Membuat tabel pembantu untuk menempatkan skor-skor pada item yang 

diperoleh. Dilakukan untuk mempermudah perhitungan atau 

pengelolaan data selanjutnya.  

e. Memberikan/menempatkan skor (scoring) terhadap item-item yang 

sudah diisi pada tabel pembantu.  

f. Menghitung nilai varians masing-masing item dan varians total. 

g. Menghitung nilai koefesien alfa.  

h. Menentukan nilai tabel koefisien korelasi pada derajat bebas (db) = n –

2.  

i. Membuat nilai kesimpulan dengan cara membandingkan nilai hitung r 

dengan nilai tabel r. Kriterinya: 

1) Jika nilai rhitung > nilai rtabel, maka intrumennya dinyatakan reliabel.  

2) Jika nilai rhitung < nilai rtabel, maka instrumennya dinyatakan tidak 

reliabel. 

Perhitungan uji reliabilitas ini dilakukan menggunakan aplikasi SPSS 

versi 25.0 dengan menggunakan rumus Alpha Cronbach. Berikut adalah 

rekapitulasi hasil Uji Reliabilitas: 
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Tabel 3.8 

Hasil Uji Validitas Tata Ruang Kantor dan  

Variabel Produktivitas Kerja Pegawai 

No Variabel Alpha 

Cronbach 

r tabel Keterangan 

1 Tata Ruang Kantor (X) 0,876 0,433 Reliabel 

2 Produktivitas Kerja (Y) 0,935 0,433 Reliabel 

Berdasarkan tabel di atas, variabel X (tata ruang kantor) dan variabel Y 

(produktivitas kerja) dikatakan reliabel karena nilai alpha lebih besar dari 

rtabel (0,433). Pada hasil uji reliabilitas di atas, diperoleh nilai koefisien 

reliabilitas angket X sebesar 0,876 dan angket Y sebesar 0,935. Dengan 

demikian, dapat disimpulkan bahwa semua angket pada penelitian ini 

dikatakan reliabel atau konsisten.  

 

3.2.6. Persyaratan Analisis Data 

Dalam melakukan analisis data, perlu dilakukan syarat pengujian 

parametrik yakni uji asumsi normalitas, homogenitas, dan linieritas sebagai 

berikut: 

1. Uji Normalitas 

Uji normalitas merupakan prosedur analisis data yang digunakan untuk 

mengetahui data yang telah dikumpulkan terdistribusi normal atau tidak 

(diambil dari populasi normal). Uji normalitas juga dilakukan untuk 

memudahkan peneliti dalam menentukan jenis analisis statistika yang akan 

digunakan. Umumnya, jika data sudah dinyatakan normal atau berasal dari 

populasi yang terdistribusi normal maka analisis statistika yang digunakan 

adalah analisis statistika parametrik. Dan sebaliknya, jika data tidak normal atau 

tidak berasal dari populasi berdistribusi normal maka menggunakan analisis 

statistik non parametrik. (Widana & Muliani, 2020) 

Uji normalitas yang penulis gunakan dalam penelitian ini adalah metode 

Lilifors Test, karena kelebihan Lilifors Test adalah penggunaan/perhitungannya 
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yang sederhana, serta cukup kuat (powerfull) sekalipun ukuran sampel kecil 

(n=4). Menurut (Nuryadi, Astuti, Utami, & Budiantara, 2017), uji normalitas 

menggunakan uji Liliefors diawali dengan penentuan taraf signifikansi, yaitu 

pada taraf signifikasi 5% (0,05).  

Adapun langkah-langkah pengujian normalitas menurut Nuryadi, Astuti, 

Utami, & Budiantara (2017) adalah sebagai berikut: 

a. Data pengamatan x1, x2, x3, …., xn dijadikan bilangan baku z1, z2, z3, …., 

zn dengan menggunakan rumus 
𝑥𝑖−𝑥̅

𝑠
  

b. Untuk setiap bilangan baku ini dengan menggunakan daftar distribusi 

normal baku, kemudian dihitung peluang 𝐹(𝑧𝑖) = 𝑃 (𝑧 <  𝑧𝑖) 

c. Selanjutnya menghitung proporsi z1, z2, z3, …., zn  yang lebih kecil atau 

sama dengan zi.  

d. Menghitung selisi F(zi) – S(zi) kemudikan tentukanlah harga mutlaknya 

e. Pilih harga yang paling besar diantara harga-harga mutlak selisih 

tersebut. 

Adapun dasar pengambilan keputusan dalam Uji Normalitas menggunakan 

Kolmogorov-Smirnov dengan SPSS, yaitu 

a. Jika nilai signifikansi (Sig.) > 0,05, maka data penelitian berdistribusi 

normal 

b. Jika nilai signifikansi (Sig.) < 0,05, maka data penelitian tidak 

berdistribusi normal 

Adapun dasar pengambilan keputusan dalam Uji Normalitas menggunakan 

Kolmogorov-Smirnov dengan SPSS, yaitu 

a. Jika nilai signifikansi (Sig.) > 0,05, maka data berdistribusi normal. 

b. Jika nilai signifikansi (Sig.) < 0,05, maka data tidak berdistribusi normal. 

Berikut merupakan langkah-langkah untuk melakuan uji normalitas 

menggunakan SPSS versi 25.0 sebagai berikut: 

a. Mempersiapkan data yang sudah diperoleh terlebih dahulu di Ms. Excel 

b. Buka Program SPSS > Copy dan paste data dari Ms. Excel 

c. Klik Variable View 
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d. Langkah selanjutnya, mencari nilai unstandardized residual (RES_1), 

caranya klik menu Analyze > Regression > Linear  

e. Muncul tampilan dialog, lalu masukan variabel Produktivitas Kerja (Y) 

pada kolom Dependent, dan variabel Tata Ruang Kantor (X) pada kolom 

Independent, jika sudah klik Save 

f. Selanjutnya akan muncul tampilan dialog, pada tampilan tersebut 

centang bagian Unstandarlized di kolom Residuals. Lalu klik Continue 

dan OK 

g. Akan muncul kolom residual (RES_1) pada data view yang selanjutnya 

akan digunakan untuk uji normalitas 

h. Klik menu Analyze > Nonparametric Tests > Legacy Dialogs > 1-

Sample K-S 

i. Pada tampilan dialog, masukkan variabel Unstandardized Residuals ke 

kotak Test Variable List, lalu centang pada pilihan Normal 

j. Terakhir, klik OK dan akan muncul tabel output dengan nama One 

Sample Kolmogorov-Smirnov Test 

Berikut merupakan hasil perhitungan Uji Normalitas data menggunakan 

aplikasi SPSS versi 25.0: 

Tabel 3.9 

Residual Result menggunakan SPSS 25.0 

Residuals Statisticsa 

 Minimum Maximum Mean Std. Deviation N 

Predicted Value 41.49 57.72 49.19 4.676 21 

Residual -15.498 8.699 .000 4.669 21 

Std. Predicted Value -1.646 1.823 .000 1.000 21 

Std. Residual -3.235 1.816 .000 .975 21 

a. Dependent Variable: Produktivitas Kerja 

Sumber: Hasil Olah Data SPSS versi 25.0 

 

Tabel 3.10 

Hasil Perhitungan Uji Normalitas Menggunakan SPSS 25.0 
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One-Sample Kolmogorov-Smirnov Test 

 

Unstandardized 

Residual 

N 21 

Normal Parametersa,b Mean .0000000 

Std. Deviation 4.66887924 

Most Extreme Differences Absolute .154 

Positive .142 

Negative -.154 

Test Statistic .154 

Asymp. Sig. (2-tailed) .200c,d 

a. Test distribution is Normal. 

b. Calculated from data. 

c. Lilliefors Significance Correction. 

d. This is a lower bound of the true significance. 

Sumber: Hasil Olah Data SPSS 25 

Berdasarkan tabel hasil uji normalitas di atas, dapat diketahui bahwa nilai 

signifikansi 0,200 > 0,05, maka dapat disimpulkan bahwa data tersebut 

berdistribusi normal. 

 

2. Uji Homogenitas 

Uji homogenitas merupakan prosedur analisis data yang dilakukan untuk 

mengetahui sama tidaknya variansi-variansi dua buah distribusi atau lebih. 

Pengujian ini dilakukan untuk kepentingan akurasi data dan keterpercayaan 

hasil penelitian bahwa skor setiap variabel memiliki variansi yang homogen 

(sama). Dalam penelitian ini, uji statistika yang akan digunakan yaitu Uji 

Barlett. Kriteria yang digunakannya adalah apabila nilai hitung 𝑥2 > nilai tabel 

𝑥2 , maka 𝐻0 menyatakan varians skornya homogen ditolak, dalam hal lainnya 

diterima. Abdurahman, Muhidin, & Somantri (2017) mengemukakan bahwa 

langkah-langkah yang dapat dilakukan dalam pengujian homogenitas varians 

sebagai berikut: 

1) Menentukan kelompok-kelompok data dan menghitung varians untuk 

tiap kelompok tersebut.  
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2) Membuat tabel pembantu untuk memudahkan proses perhitungan 

dengan model tabel sebagai berikut: 

Tabel 3.11 

Mode Tabel Uji Barlett 

Sampel Db = n-1 S2
i LogS2

i db. LogS2
i db.S2

i 

1      

2      

3      

…      

∑      

Sumber: Abdurahman, Muhidin, & Somantri (2017) 

3) Menghitung varians gabungan 

4) Menghitung log dari varians gabungan 

5) Menghitung nilai Barlett 

6) Menghitung nilai x2 

7) Menentukan nilai dan titik krisis pada α = 0,05 dan db = k – 1, di mana 

K adalah banyaknya indikator 

8) Membuat kesimpulan dengan kriteria sebagai berikut: 

a. Nilai x2 hitung < nilai x2 tabel 𝐻0 diterima (variasi data dinyatakan 

homogen).  

b. Nilai x2 hitung ≥ nilai x2 tabel 𝐻0 ditolak (variasi data tidak 

dinyatakan homogen). 

Adapun dasar pengambilan keputusan dalam Uji Homogenitas 

menggunakan Uji Bartlett dengan SPSS, yaitu: 

a. Jika nilai signifikansi (Sig.) > 0,05, maka varian data homogen, artinya 

asumsi uji homogenitas terpenuhi. 

b. Jika nilai signifikansi (Sig.) < 0,05, maka varian data tidak homogen, 

artinya asumsi uji homogenitas tidak terpenuhi. 

Berikut merupakan langkah-langkah untuk melakukan uji homogenitas 

Barlett menggunakan SPSS 25.0: 
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a. Mempersiapkan data yang sudah diperoleh terlebih dahulu di Ms. Excel 

b. Pada Ms. Excel, data variabel X dan Y digabung dan diberi kode “1” 

untuk variabel X dan “2” untuk variabel Y 

c. Buka Program SPSS > Copy dan paste data dari Ms. Excel 

d. Klik Variable View > beri Label “Variabel” untuk pengkodean data dan 

“Hasil Angket” untuk data variabel Tata Ruang Kantor (X) dan 

Produktivitas Kerja (Y) 

e. Pada Kolom Values, beri keterangan bahwa angka 1 untuk X dan angka 

2 untuk Y 

f. Klik Analyze > Classify > Discriminant 

g. Selanjutnya akan muncul tampilan dialog, masukkan “Hasil Angket” 

pada kolom Grouping Variable dan masukkan “Variabel” pada kolom 

Independents 

h. Pada kolom Grouping Variable > Define Range > masukkan angka 1 

pada kolom minimum dan angka 2 pada kolom maksimum 

i. Statistics > klik Box’s M > Continue 

j. Terakhir klik OK untuk mendapatkan hasil dari uji homogenitas 

Berikut merupakan data hasil perhitungan Uji Homogenitas menggunakan 

aplikasi SPSS versi 25.0: 

Tabel 3.12 

Hasil Perhitungan Uji Homogenitas menggunakan SPSS 25.0 

Test Results 

Box's M .533 

F Approx. .520 

df1 1 

df2 4800.000 

Sig. .471 

Tests null hypothesis of equal 

population covariance matrices. 

Sumber: Hasil Olah Data SPSS 25 

Berdasarkan tabel hasil uji homogenitas di atas, diketahui bahwa nilai 

signifikansi yang diperoleh sebesar 0,471 > 0,05, maka dapat disimpulkan 



64 
 

 
 
Citra Salsabila, 2023 

PENGARUH TATA RUANG KANTOR TERHADAP PRODUKTIVITAS KERJA PEGAWAI DI KANTOR 
PELAYANAN DINAS SOSIAL KOTA BANDUNG 
Universitas Pendidikan Indonesia | repository.upi.edu | perpustakaan.upi.edu 

bahwa varian data homogen (sama) atau asumsi uji homogenitas sudah 

terpenuhi. 

 

3. Uji Linieritas 

Uji linieritas merupakan prosedur analisis data yang dilakukan untuk 

mengetahui hubungan antara variabel terikat dan variabel bebas yang diuji 

bersifat linier atau tidak secara signifikan. Abdurahman, Muhidin, & Somantri 

(2017) mengemukakan langkah-langkah yang dapat dilakukan dalam pengujian 

linieritas regresi sebagai berikut: 

1) Membuat tabel kelompok data variabel x dan variabel y 

2) Menghitung jumlah kuadrat regresi (JKreg(a)) dengan rumus: 

JKreg(a) = 
(∑𝑌)2

𝑛
 

3)  Menghitung jumlah kuadrat regresi b | a (JKreg(a)) dengan rumus: 

JKreg(b\ a) = b.∑ 𝑋𝑌 -  
∑ 𝑋.∑𝑌

𝑛
 

4) Menghitung jumlah kuadrat residu (JKres) dengan rumus: 

5) Menghitung rata-rata jumlah kuadrat regresi b/a (RJKreg(a)) dengan 

rumus: 

6) Menghitung rata-rata jumlah kuadrat regresi b/a (RJKreg(a)) dengan 

rumus: 

7) Menghitung rata-rata jumlah kuadrat residu (JKres) dengan rumus: 

8) Menghitung jumlah kuadrat error (JKE) dengan rumus: 

9) Menghitung jumlah kuadrat tuna cocok (JKTC) dengan rumus: 

10) Menghitung rata-rata jumlah kuadrat tuna cocok (JKTC) dengan rumus: 

11) Menghitung rata-rata jumlah kuadrat error (RJKE) dengan rumus: 

12) Mencari nilai uji F dengan rumus: 

13) Menentukan kriteria pengukuran: Jika nilai uji F > nilai tabel F, maka 

distribusi berpola linier 

14) Mencari nilai Ftabel pada taraf signifikansi 95% atau a = 5% 

menggunakan rumus: Ftabel = F (1-a)(db TC, db E) dimana db TC = k-2 dan db 

E = n – k  
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15) Membandingkan nilai uji F dengan nilai tabel F kemudian membuat 

kesimpulan 

Adapun dasar pengambilan keputusan dalam Uji Linearitas dengan SPSS, 

yaitu 

• Jika nilai signifikansi (Sig.) pada Deviation from Linearity > 0,05, maka 

terdapat hubungan yang linear secara signifikan antara variabel bebas 

dan variabel terikat 

• Jika nilai signifikansi (Sig.) pada Deviation from Linearity < 0,05, maka 

tidak terdapat hubungan yang linear secara signifikan antara variabel 

bebas dan variabel terikat 

Langkah-langkah untuk melakuan uji lineritas menggunakan SPSS 25.0 

adalah sebagai berikut: 

a. Mempersiapkan data yang sudah diperoleh terlebih dahulu di Ms. Excel 

b. Buka Program SPSS > Copy dan paste data dari Ms. Excel 

c. Klik Variable View > Analyze > Compare Means > Means 

d. Setelah itu, akan muncul tampilan dialog lalu masukkan variabel 

Produktivitas Kerja (Y) pada kolom Dependent List dan variabel Tata 

Ruang Kantor (X) pada kolom Independent List 

e. Selanjutnya klik Options, dan pastikan pada kolom Cell Statistics berisi 

Mean, Number of Cases dan Standard Deviation. Lalu beri centang pada 

Test of Linearity 

f. Terakhir klik OK untuk mendapatkan hasil dari uji linearitas 

Berikut merupakan data hasil perhitungan Uji Homogenitas menggunakan 

aplikasi SPSS versi 25.0: 
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Tabel 3.13 

Hasil Perhitungan Uji Linearitas menggunakan SPSS 25.0 

 
Sumber: Hasil Olah Data SPSS 25 

Berdasarkan tabel hasil uji linearitas di atas, diketahui bahwa nilai sig. 

deviation from linearity sebesar 0,298 > 0,05, maka dapat disimpulkan bahwa 

terdapat hubungan yang linear antara Tata Ruang Kantor dengan Produktivitas 

Kerja. 

3.2.7. Teknik Analisis Data 

1. Teknik Analisis Deskriptif 

Statistik deskriptif merupakan statistik yang digunakan untuk menganalisis 

data dengan cara mendeksripsikan atau menggambarkan data yang telah 

terkumpul sebagaimana adanya tanpa bermaksud membuat kesimpulan yang 

berlaku untuk umum atau generalisasi. (Sugiyono, 2012)  

Adapun statistik deskriptif pada penelitian ini digunakan untuk menjawab 

rumusan masalah yang tertera pada nomor satu dan dua yaitu untuk mengetahui 

gambaran kesesuaian penggunaan tata ruang kantor dan tingkat produktivitas 

kerja pegawai di Dinas Sosial Kota Bandung.  

Untuk memudahkan peneliti dalam mendeskripsikan variabel penelitian, 

maka digunakan kriteria tertentu yang mengacu pada skor angket yang diperoleh 

dari responden. Data yang diperoleh dari responden kemudian diolah sehingga 

akan menghasilkan skor dan kedudukan responden berdasarkan urutan angket 

yang masuk untuk masing-masing variabel. Adapun skor pada hasil angket 

menggunakan skala Likert. Musfiqon (2012) mengatakan bahwa skala Likert 

digunakan untuk mengukur sikap, pendapat, dan persepsi seseorang atau 

kelompok orang tentang fenomena sosial. Pengukuran skor skala Likert 

mengacu pada: 
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Tabel 3.14  

Kriteria Penafsiran Alternatif Jawaban 

Tingkat Skor (Modus) 

Sangat Baik 5 

Baik  4 

Cukup Baik 3 

Kurang Baik 2 

Sangat Kurang Baik 1 

Untuk mengetahui bagaimana kesesuaian tata ruang kantor dan tingkat 

produktivitas kerja pegawai, maka analisis data menggunakan analisis deskriptif 

dengan distribusi frekuensi/modus. 

2. Teknik Analisis Data Inferensial 

Analisis statistik inferensial merupakan data dengan statistik yang 

digunakan dengan tujuan untuk membuat kesimpulan yang berlaku umum. Dalam 

praktik penelitian, analisis statistika inferensial biasanya dilakukan dalam bentuk 

pengujian hipotesis. (Muhidin, Abdurahman, & Sontani, 2011) 

Analisis inferensial digunakan untuk menjawab pertanyaan yang telah 

dipaparkan di dalam rumusan masalah. Untuk mempermudah dalam 

mendeskripsikan variabel penelitian, digunakan kriteria tertentu yang mengacu 

pada skor kategori angket yang diperoleh dari responden,, karena penelitian ini 

menggunakan data dalam bentuk skala ordinal seperti yang dijelaskan dalam 

operasional maka untuk menghitung rata-rata skor jawaban responden, data 

ordinal hasil pengukuran diubah terlebih dahulu menjadi data interval dengan 

menggunakan Metode Succesive Interval (MSI). 

Metode Succesive Interval (MSI) dapat dioperasikan dengan salah satu 

program tambahan pada Microsoft Excel, yaitu Program Succetive Interval. 

Adapun langkah-langkah untuk mengubah data dengan MSI, dilakukan sebagai 

berikut: 

a. Input skor yang diperoleh pada lembar kerja (worksheet) Excel.  
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b. Klik “Analize” pada menu bar.  

c. Klik “Succesive Interval” pada menu analize, hingga muncul kotak dialog 

“Methode of Succesive Interval”  

d. Klik “Drop Down” untuk mengisi data range pada kotak dialog Input, 

dengan cara memblok skor yang akan diubah skalanya.  

e. Pada kotak dialog tersebut, kemudian chek list (√) Input Label in First Now.  

f. Pada Option Min Value isikan/pilih 1 dan Max Value isikan/pilih 5.   

g. Masih pada Option, check list (√) Display Summary.  

h. Selanjutnya pada Output, tentukan Cell Output, hasilnya akan ditempatkan 

di sel mana. Lalu klik “OK”. 

Setelah mendapat nilai interval dari proses MSI maka dapat diproses dengan 

teknik analisis data inferensial yang terdiri dari 5 langkah yakni (1) merumuskan 

hipotesis statistic; (2) menghitung regresi; (3) menentukan taraf kemaknaan, (4) 

menentukan uji signifikasi; dan (5) menghitung koefisien korelasi dan koefisien 

determinasi. 

Statistik non parametrik yang digunakan dalam penelitian ini yaitu uji 

regresi linier sederhana yang merupakan model persamaan yang menggambarkan 

hubungan satu variabel bebas (X) dengan satu variabel tak bebas (Y). persamaan 

regresi linier sederhana secara matematik dirumuskan sebagai berikut: (Suyono, 

2015) 

𝑌̂ = a + bX 

 Dimana : 

 𝑌̂ : Garis regresi/variabel response 

 a  : Konstanta, perpotongan dengan sumbu vertical 

 b  : Konstanta regresi (slope) 

 X  : Variabel bebas  

 Besarnya konstanta a dan b dapat ditentukan menggunakan persamaan: 

 a = 
(∑ 𝑌𝑖) (∑ 𝑋𝑖

2) − (∑ 𝑋𝑖) (∑ 𝑋𝑖𝑋𝑖)

𝑛 ∑ 𝑋𝑖
2− (∑ 𝑋𝑖)2  
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 b = 
𝑛 (∑ 𝑋𝑖𝑋𝑖) − (∑ 𝑋𝑖) (∑ 𝑌𝑖) 

𝑛 ∑ 𝑋𝑖
2− (∑ 𝑋𝑖)2  

 dimana n = jumlah data 

3.2.8. Pengujian Hipotesis 

1. Merumuskan Hipotesis 

Menurut Tatang & Muhidin (2011), hipotesis merupakan jawaban 

sementara terhadap permasalahan yang sudah dirumuskan. Dikarenakan 

hipotesis merupakan jawaban yang bersifat sementara, maka perlu dilakukan 

pengujian untuk memperoleh sebuah kesimpulan apakah suatu hipotesis diterima 

atau ditolak. Pengujian hipotesis bertujuan untuk mengetahui bagaimana 

pengaruh antara variabel bebas dan variabel terikat. 

Langkah-langkah dalam pengujian hipotesis menurut Abdurahman, 

Muhidin, & Somantri (2017) adalah sebagai berikut: 

a. Nyatakan hipotesis statistik (H0 dan H1) yang sesuai dengan hipotesis 

penelitian yang diajukan. Adapun hipotesis yang diajukan dalam 

penelitian ini adalah sebagai berikut: 

H0 : β = 0, artinya tidak ada pengaruh tata ruang kantor terhadap 

produktivitas kerja pegawai di Kantor Pelayanan Dinas 

Sosial Kota Bandung 

H1 :  β  ≠ 0, artinya ada pengaruh tata ruang kantor terhadap 

produktivitas kerja pegawai di Kantor Pelayanan Dinas 

Sosial Kota Bandung 

dimana β adalah koefisien regresi pada populasi yang didekati oleh 

koefisien regresi sampel b 

b. Menentukan taraf kemaknaan atau nyata 𝛼 (level of significance 𝛼) 

c. Menggunakan statistik uji yang tepat 

d. Tentukan titik kritis dan daerah kritis (daerah penolakan) H0 

e. Hitung nilai statistik uji berdasarkan data yang dikumpulkan. Perhatikan 

pula apakah nilai hitung statistik uji jatuh di daerah penerimaan atau 

daerah penolakan? 
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f. Berikan kesimpulan  

 

2. Analisis Regresi Sederhana 

Analisis regresi dipergunakan untuk menelaah hubungan antara dua 

variabel atau lebih, terutama untuk menelusuri pola hubungan yang modelnya 

belum diketahui dengan sempurna, atau untuk mengetahui bagaimana variasi 

dari beberapa variabel independent mempengaruhi variabel dependen dalam 

suatu fenomena yang kompleks. (Abdurahman, Muhidin, & Somantri, 2017) 

Menurut Furqon (2018) dalam pengujian hipotesis pada analisis korelasi 

sederhana dapat menggunakan pengujian hipotesis nol. Dalam menguji 

hipotesis bahwa koefisien korelasi populasi antara dua peubah sama dengan nol 

(tidak ada hubungan) dapat dilakukan dengan menghitung nilai t. Adapun 

rumus menghitung nilai t adalah sebagai berikut: 

t = 
𝑏

𝑠𝑒(𝑏)
 

 dimana : 

 b  = koefisien regresi 

 se(b)    = standar error dari b 

Jika hipotesis nol benar, statistik tersebut akan mengikuti distribusi normal 

t dengan derajat kebebasan n – 2. 

Adapun model persamaan regresi sederhana adalah: 

𝑌̂ = 𝑎 + 𝑏𝑥 

Dimana: 

𝑌̂ = variabel tak bebas (terikat) 

 = variabel bebas 

𝑎 = penduga bagi intersap (𝑎) 

𝑏 = penduga bagi koefisien regresi () 

𝑎 dan  adalah parameter yang nilainya tidak diketahui sehingga diduga 

menggunakan statistik sampel. 

Adapun langkah-langkah yang dilakukan untuk mendapatkan persamaan 
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regresi sederhana adalah sebagai berikut: 

a. Menempatkan skor hasil tabulasi pada sebuah tabel untuk memudahkan 

proses perhitungan 

b. Menghitung rata-rata skor variabel X dan rata-rata skor variabel Y 

c. Menghitung koefisien regresi (b), dengan rumus berikut: 

𝑏 =  
𝑁. (∑ 𝑋𝑌) − ∑ 𝑋 ∑ 𝑌

𝑁. ∑ 𝑋2 − (∑ 𝑋)2
 

d. Menghitung nilai 𝛼, dengan rumus berikut: 

𝑎 =  𝑌̅ − 𝑏𝑋̅ 

e. Menentukan persamaan regresi dengan rumus berikut: 

𝑌̂ = 𝑎 + 𝑏𝑥 

Syarat uji regresi linear sederhana adalah data yang digunakan harus valid 

dan reliabel serta berdistribusi normal dan linear. Adapun pengambilan 

keputusan dalam uji regresi linear sederhana dapat mengacu pada dua hal, 

yakni:  

• Jika nilai signifikansi < 0,05, maka variabel X berpengaruh terhadap 

variabel Y. 

• Jika nilai signifikansi > 0,05, maka variabel X tidak berpengaruh terhadap 

variabel Y. 

 Sedangkan, langkah-langkah yang dilakukan untuk mendapatkan 

persamaan regresi sederhana menggunakan SPSS versi 25.0 adalah sebagai 

berikut: 

a. Mempersiapkan data yang sudah diperoleh terlebih dahulu di Ms. Excel 

b. Buka Program SPSS > Copy dan paste data dari Ms. Excel 

c. Klik Variable View > Ganti nama VAR00001 dengan X dan Y > ubah 

kolom decimal menjadi angka 0 > beri Label dengan “Tata Ruang Kantor” 

dan “Produktivitas Kerja” 

d. Klik Data View > Analyze > Regression > Linear 
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e. Selanjutnya akan muncul tampilan dialog, masukkan variabel Tata Ruang 

Kantor (X) pada kotak Independents dan variabel Produktivitas Kerja (Y) 

pada kotak Dependent 

f. Terakhir klik OK, dan selanjutnya akan muncul hasil perhitungan dari 

regresi linear sederhana 

3. Koefisien Korelasi 

Analisis korelasi sederhana diartikan sebagai suatu analisis data yang 

bermakud untuk melihat hubungan antara dua variabel. Tujuan dilakukannya 

analisis korelasi, antara lain: 

a. Untuk mencari bukti terdapat tidaknya hubungan (korelasi) antar variabel 

b. Untuk melihat seberapa besar hubungan antar variabel tersebut 

c. Untuk memperoleh kejelasan dan kepastian apakah hubungan tersebut 

berarti (meyakinkan atau signifikan) atau tidak berarti (tidak meyakinkan) 

Pada penelitian ini menggunakan korelasi product moment yang 

dikembangkan oeh Karl Pearson. Adapun korelasi product moment dapat 

dihitung menggunakan rumus sebagai berikut: 

𝑟𝑥𝑦 =  
𝑁 ∑ 𝑋𝑌 − (∑ 𝑋). (∑ 𝑌)

√[𝑁 ∑ 𝑋2 −  (∑ 𝑋2)]. [𝑁 ∑ 𝑌2 − (∑ 𝑌2)]
 

Pada hasil perhitungan tersebut, perhatikan tanda plus minus (±) pada angka 

indeks korelasi. Tanda tersebut berfungsi untuk menunjukkan arah korelasi. 

Jika angka indeks korelasi bertanda plus (+) maka korelasi tersebut positif dan 

arah korelasi satu arah, sedangkan apabila indeks korelasi bertanda minus (-) 

maka korelasi tersebut negative dan arah korelasi berlawanan arah, terakhir jika 

angka indeks korelasi sama dengan 0, maka hal ini menunjukkan tidak adanya 

korelasi. 

Untuk melihat tingkat pengaruh dari variabel X terhadap variabel Y, maka 

bandingkan dengan tabel korelasi berikut: 
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Tabel 3.15 

Kriteria Interpretasi Koefisien Korelasi 

Besar rxy Interpretasi 

0,00 - < 0,20 Hubungan sangat lemah (diabaikan, dianggap tidak ada) 

≥ 0,20 - < 0,40 Hubungan rendah 

≥ 0,40 - < 0,70 Hubungan sedang atau cukup 

≥ 0,70 - < 0,90 Hubungan kuat atau tinggi 

≥ 0,90 - ≤ 1,00 Hubungan sangat kuat atau sangat tinggi 

 

4. Koefisien Determinasi 

Koefisien determinasi merupakan kuadrat dari koefisien korelasi (r2) yang 

berkaitan dengan variabel bebas dan variabel terikat. Koefisien determinasi 

digunakan sebagai upaya untuk melihat besarnya pengaruh variabel bebas 

terhadap variabel terikat. Dalam analisis regresi, koefisien determinasi ini 

biasanya dijadikan dasar dalam menentukan besarnya pengaruh variabel bebas 

terhadap variabel terikat. Adapun rumus yang digunakan untuk melihat 

besarnya pengaruh variabel bebas terhadap variabel terikat atau besarnya 

kontribusi variabel bebas terhadap variabel terikat adalah koefisien korelasi 

dikuadratkan lalu dikali dengan 100% (r2 x 100%). (Abdurahman, Muhidin, & 

Somantri, 2017) 

 


